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Summary


ODBC or Open DataBase Connectivity is middleware that allows a client to seamlessly communicate with any relational database and is transparent to the user. This middleware resides on both server and client in an n-tier architecture.  This presentation demonstrates the ODBC capabilities.  In a typical business scenario, a two-tier architecture hardware consists of a server and several client machines.  Client machines in the form of two IBM ThinkPad laptops, running Windows 95 and Windows 2000 Professional respectively, have MS  Access, MS Excel, MS Word and MSQuery, as well as Visual Basic and ActiveX. The P100 server has 48 MB RAM  with a SCSI hard drive, Windows NT 4.0 Workstation and DHCP addressing. The server and clients are connected using Category 5 cable and a 3Com model TP4  hub with 4 ports. The MySQL database, which resides on the server, and the MySQL ODBC driver are available free online at http://www.mysql.org.

2-Tier Client/Server Architecture 

for Bob’s Bike Shop
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For demonstration purposes, an inventory system has been created for Bob’s Bike Shop. ODBC provides the interface to MySQL database on the server to access the two tables, manufacturer and inventory where standard relational database functions such as update, delete and query are available.  To further demonstrate the capabilities of the ODBC and expand the functionality available to the business, ODBC acts as an interface between the MySQL database and MS Excel providing data for Excel features such as charting.   Next, ODBC acts as in interface to MS Word and using MS Query, a form letter is created.  The final ODBC functionality demonstrated is the use of ODBC to provide data to the MS Access database, giving the user further options in storing and manipulating the data.   

The Database

The Class Diagram







The Schema

create table inventory (model char(10) Not Null, color char(10) Not Null, size int(11) Not Null Default 0, 

gender char(1) Not Null, instock int(11) Default 0, onorder int(1) Not Null, 

manid int(9) Not Null Default 0, invid int(9) Not Null Auto_Increment,

Primary Key (invid), Unique id (invid),FOREIGN KEY(manid) REFERENCES manufacturer(manid) )

create table manufacturer (company char(25) Not Null, address1 char(25) Not Null, address2 char(25),

city char(15) Not Null, state char(12) , country char(12) Not Null, mailcode char(12), contact char(25), 

phone char(12), email char(30),manid int(9) Not Null Auto_Increment, Primary Key (manid), Unique id (manid) )

Supporting Documentation, Code, Screen Shots and References 


A splash screen is displayed before the database interface to introduce the application.  This code and the splash screen is presented in Appendix A.  Application Programming Interface(API) is written in Microsoft Active X  with Microsoft ADO 6 Data Control and Data Grid 6 as components for the interface.  The code is presented in its entirety in Appendix C.  


Instructions concerning the initial set up, including installing the MySQL database and MySQL ODBC driver on the server and client are found in Appendix B, Appendix D, 

Appendix E, Appendix F, and Appendix H.  Useful reference links have been provided in Appendix G.  All information concerning supplying data from the MySQL database to use in MS Access is present in Appendix I.   Appendix J and Appendix K contain information to make data available to MS Excel from the MySQL database and an example chart. 


Comprehensive written instructions, complete code, and screen shots have been encapsulated in the following appendices. This list is provided for ease of reference:

· Appendix A 
Splash Screen and Code

· Appendix B
Instructions to Create the MySQL Database on the  Windows Client

· Appendix C
API code Written in MS Active X

· Appendix D
Installing and Using ODBC in Client/Server Architecture

· Appendix E
ODBC Installation Code and Tips for the Server

· Appendix F
SQL Code to Create MySQL Database on the Server

· Appendix G
ODBC Reference Links

· Appendix H
Screen Shots of ODBC Installation and Configuration

· Appendix I
Using MS Access with MySQL ODBC Driver

· Appendix J
MS Excel Add-ins Screen Shots and Directions

· Appendix K
MS VBA Code Used with MS Excel

· Appendix L
MS Word Mail Merge Using ODBC         

 Appendix A

Splash Screen


'Code for the splash screen

‘Written by Chris Davis

Private Sub Form_Load()

  Center_Form Me

  Me.Show

  DoEvents

  Dim dtThen As Date

  dtThen = DateAdd("s", 3, Now) 'adjust delay time as needed

  Load frmMySQL2

  Center_Form frmMySQL2

  Do While Now < dtThen

    DoEvents

  Loop

  frmMySQL2.Show

  Unload Me

End Sub


'This module (Common.bas) was written by John Carter 04/20/2002

'It is used to center the form when the procedure Center_Form is called

Public Sub Center_Form(F As Form)

  Dim MyX As Integer

  Dim MyY As Integer

  MyX = (Screen.Width - F.Width) / 2

  MyY = (Screen.Height - F.Height) / 2

  F.Move MyX, MyY

End Sub


'This code was written by John Carter 04/20/2002

'It calls Common.bas module which centers the splash screen

Private Sub Form_Load()

  Center_Form Me

  Me.Show

  DoEvents

  Dim dtThen As Date

  dtThen = DateAdd("s", 3, Now) 'adjust delay time as needed

  Load frmMySQL2

  Center_Form frmMySQL2

  Do While Now < dtThen

    DoEvents

  Loop

  frmMySQL2.Show

  Unload Me

End Sub

Appendix B

Instructions to Create the MySQL Database on the Windows Client
Helpful information is found on the MySQL web site: http://www.mysql.com/ 

Download Database

· Click on the Downloads section on the site to get to the database downloads

· Click on the MySQL 3.23 database link:

· Click on the link, which applies to your operating system platform

· Pick the appropriate country for the download.  You might have to go through a couple to pick the fastest speed.

· You will be prompted to pick the location of the download.

Download ODBC Driver

· Now go back to the page where you picked out the database and scroll down until you see the link for the ODBC drivers

· Pick the OS

· Pick the region for the download

· You should now have the database and ODBC installation files on your machine

Database Installation

· Click on the database file first to expand the file

· Click on the folder for the database and then the Setup.exe program to begin the installation of the database

· Click Next

· Select the install location and click Next

· Select which type of installation you would like to do (Typical for most)

· Click on Finish to end the database installation

ODBC Driver Installation

· Click on the ODBC file to begin the installation
· Click Next
· Click Next
· Click Next
· Installation Running
· Click Finish to Finish the Install
Database Configuration

· Go to the MySQL directory that you created in the installation
· Go to the Bin directory and click on the winmysqladmin.exe program to register your database
· Create a user id and password and click on the OK button to save.  You should now be able to see the MySQL traffic light in the lower right hand corner of your desktop.  This means the MySQL service is now running.  Let’s create your database!
· Click on the Traffic light and then select show me to bring up the admin tool.
· Click on the database tab to begin adding the database
· Right Click in the admin tool and choose Create Database
· Type in the name of your new database and click on the Create button
· Click on OK to save your changes
· Add more databases if you want; otherwise, you have just created your first MySQL database!
Create and Populate the Tables

· While in the Bin directory, click on the MySQLManager.exe program to bring up the manager screen.
· If you created your database in the Test directory, then you can click on the test folder and you should see the directory for your new database
· Right Click on you database and choose the SQL Query menu selection.  This should bring up the text window (Query Pane!), which will allow you to create and populate your tables.  
· Here is a sample script that I used to create my table:
create table inventory (model char(10) Not Null, color char(10) Not Null, size int(11) Not Null Default 0, gender char(1) Not Null, instock int(11) Default 0, onorder tinyint(1) Not Null, 

manid mediumint(9) Not Null Default 0, invid mediumint(9) Primary Key Not Null Auto_Increment)

· Once you have the script in the text page, click on the green arrow to add the table to your database.  If the results screen is blank, you were successful. 
· Add as many tables as you wish.
· When you ready to populate the tables, use a sample script like the one below
insert into inventory (model, color, size, gender, instock, onorder, manid) values ('a2349', 'red', 24, 'M', 3, 0, 1),('a2413', 'blue', 26, 'M', 1, 0, 1),('a2519', 'green', 20, 'F', 1, 0, 1),('a3214', 'blue', 27, 'M', 2, 0, 1),('a3217', 'red', 24, 'F', 0, 1, 1),('a3314', 'silver', 20, 'F', 4, 0, 1),('a2566', 'pink', 19, 'F', 2, 0, 1,),('d239','red',27,'m',5,1,1),('d293','brown',27,'m',2,0,1),('d129','silver',25,'f',1,1,1),('a9h34','black',27,'m',2,0,2),('r194','brown',26,'m',1,0,2),('ah90','blue',25,'f',3,0,2),('ah99','blue',27,'m',3,0,2),('zn222','gold',27,'m',3,1,3),('zf227','gold',25,'f',3,0,3),('a93247','red',27,'m',1,0,3),('a93244','red',25,'f',1,0,4),('2002r24','green',25,'m',0,1,4),('2002y26','yellow',26,'m',0,1,4),('rhf237','silver',27,'m',2,0,4),('lff236','white',26,'f',2,0,5),('mf287','white',27,'m',2,0,5),('rf286','gray',26,'m',4,0,5),('fe299','black',24,'m',3,0,5),('le293','red',26,'f',5,1,5)

· Put the script in the same text box as you did before. – Hint – Make sure you’re not entering your script in the results pane or you won’t be able to create the rows!
· Now run a simple query to look at your created table: select * from inventory

model
color
size
gender
instock
onorder
manid
invid


-----
-----
----
------
-------
-------
-----
-----


a2349
red
24
M
3
0
1
1


a2413
blue
26
M
1
0
1
2


a2519
green
20
F
1
0
1
3


a3214
blue
27
M
2
0
1
4


a3217
red
24
F
0
1
1
5


a3314
silver
20
F
4
0
1
6


a2566
pink
19
F
2
0
1
7


d239
red
27
m
5
1
1
8


d293
brown
27
m
2
0
1
9


d129
silver
25
f
1
1
1
10


a9h34
black
27
m
2
0
2
11


r194
brown
26
m
1
0
2
12


ah90
blue
25
f
3
0
2
13


ah99
blue
27
m
3
0
2
14


zn222
gold
27
m
3
1
3
15


zf227
gold
25
f
3
0
3
16


a93247
red
27
m
1
0
3
17


a93244
red
25
f
1
0
4
18


2002r24
green
25
m
0
1
4
19


2002y26
yellow
26
m
0
1
4
20


rhf237
silver
27
m
2
0
4
21


lff236
white
26
f
2
0
5
22


mf287
white
27
m
2
0
5
23


rf286
gray
26
m
4
0
5
24


fe299
black
24
m
3
0
5
25


le293
red
26
f
5
1
5
26


(26 row(s) affected)

· You should be able to keep populating the tables as much as you wish.
ODBC Configuration

· Run the ODBC Data Source Administrator (odbcad32.exe).
· Under the User DSN tab, click Add
· Scroll down and highlight the MySQL 3.51 Driver and click Finish
· Choose a Data Source Name.  Make sure you can remember this because you will be using this same name in your VB code!
· Under the Host Server Name/IP, type in localhost if your database is on your machine.  If you are going to use a database on another machine, you will then need to type in either the IP address of the computer or the name (if using DNS)
· Type in the user id and password if needed – Remember when you registered the database, you added a user id and password.  If you don’t use the same information here, you won’t connect in VB!
· Click on OK
· Click on OK
**** You have now successfully installed and configured you database and ODBC driver for the exercise.  Please begin the coding phase of the project.
Appendix C

Code for ActiveX Interface

Option Explicit

'All code on this page is from Chris Lee Davis 04/20/2002

'I used the Microsoft Active X 2.6 Reference Library

'I used the Microsoft ADO 6 Data Control and Data Grid 6 as components 

for the form

'

'

'These are the global variables I used for creating connections to the 

MySQL

'database.

Dim cnnBikes As New ADODB.Connection

Dim cnnBikes2 As New ADODB.Connection

Dim cmdBikes As New ADODB.Command

Dim cmdBikes2 As New ADODB.Command

Dim rsMan, rsMan2 As New ADODB.Recordset

Dim sSQLInv, sSQLMan, sSQLMan2, sSQLMan3, sDSN As String

Dim lManID, lInvID As Long

Private Sub cboManName_Click()

'This event fills in the rest of the manufacturer boxes if the user

'has clicked on the value in the combo box.  I use this event to help

'the user add an inventory item for an existing manufacturer already

'found in the database.

'

Dim Found As Boolean

Found = False

With Data2.Recordset

.MoveFirst

Do Until Found

    If cboManName.Text = !company Then

        txtAddressOne.Text = .Fields(1)

        txtAddressTwo.Text = .Fields(2)

        txtCity.Text = .Fields(3)

        txtState.Text = .Fields(4)

        txtCountry.Text = .Fields(5)

        txtMailCode.Text = .Fields(6)

        txtContact.Text = .Fields(7)

        txtPhone.Text = .Fields(8)

        txtEmail.Text = .Fields(9)

        txtManID.Text = .Fields(10)

        Found = True

        .MoveNext

    Else

        .MoveNext

    End If

Loop

End With

End Sub

Private Sub Close_Click()

'Terminate the program when the Quit button is clicked.

Unload Me

End Sub

Private Sub cmdAddInventory_Click()

'This event allows the user to add an inventory item to the MySQL 

database

'I call the two Connect functions to connect the 2 data controls with 

the

' ODBC connection.  I want to disable the search buttons on the form, 

enable and

' empty the inventory boxes to allow the user to add the inventory 

record, empty

' the manufacturer boxes so the user can select the manufactuer from 

the combo box,

' make the inventory save button visible to user, and then hide the 

following

' buttons from the user: Modify Inventory, Save Manufacturer, Modify 

Manufacturer,

' and Delete Manufacturer.

'

'Please note - the actual adding of the inventory item is not done 

here!  It is

'carried out in the cmdSaveInventory event.

cboManName.Enabled = True

Call Connect_Data1_With_Inv

Call Connect_Data2_With_Man

Call Disable_Search_Buttons

Call Enable_Inventory_Boxes

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Inv

cmdSaveInventory.Visible = True

cmdModifyInv.Visible = False

cmdDeleteInventory.Visible = False

cmdSaveMan.Visible = False

cmdModifyMan.Visible = False

cmdDeleteManufacturer.Visible = False

' This loop is designed to fill the Manufacturer combo box with all of 

the

' manufacturer names so the user may select a manufacturer for the 

inventory

' item they want to add.

Data2.Recordset.MoveFirst

cboManName.Clear

Do Until Data2.Recordset.EOF

    cboManName.AddItem Data2.Recordset!company

    Data2.Recordset.MoveNext

Loop

End Sub

Private Sub cmdAddManufacturer_Click()

'This event cleans out the manufacturer fields and disables the

'inventory fields so the user can add a manufacturer.

'

'Please note - this event does NOT actually add the manufacturer but 

sets the

'screen up so we CAN add a manufacturer.  The real adding to the 

database

'goes on in the cmdSaveMan event

cmdSaveMan.Visible = True

cmdModifyMan.Visible = False

cmdDeleteManufacturer.Visible = False

cmdSaveInventory.Visible = False

cmdModifyInv.Visible = False

cmdDeleteInventory.Visible = False

Call Connect_Data1_With_Man

Call Disable_Search_Buttons

Call Empty_Manufacturer_Boxes_Inv

Call Empty_Inventory_Boxes

Call Disable_Inventory_Boxes

Call Enable_Manufacturer_Boxes

End Sub

Private Sub cmdDeleteInventory_Click()

'This button is designed to delete the current Inventory record from 

the

'MySQL database.  Because we are deleting here, I want to disable the

'the manufacturer buttons to stop the user from deleting more than the

'inventory record.

'

'I make sure to ask the user to verify the record that they want to

'delete before the actual record is deleted from the MySQL database.

'

Call Disable_Manufacturer_Boxes

Call Enable_Inventory_Boxes

Dim Response As String

With Data1.Recordset

    Response = MsgBox("Delete ID# " & !invid & ", Model # " _

        & !model, vbYesNo)

If Response = vbYes Then

    .Delete

    .Update

Else

    MsgBox "Delete Operation Has Been Cancelled!"

End If

.Requery

End With

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Inv

End Sub

Private Sub cmdDeleteManufacturer_Click()

'This button is designed to delete the current Manufacturer record from 

the

'MySQL database.  Because we are deleting here, I want to disable the

'the inventory buttons to stop the user from deleting more than the

'manufacturer record.

'

'I make sure to ask the user to verify the record that they want to

'delete before the actual record is deleted from the MySQL database.

'

'

'

'

Call Enable_Manufacturer_Boxes

Call Disable_Inventory_Boxes

Dim Response As String

With Data1.Recordset

    Response = MsgBox("Delete ID# " & !manid & ", Company: " _

        & !company, vbYesNo)

If Response = vbYes Then

    'I use the following code to delete the corresponding records in 

the

    'inventory table that have the manufacturer's foreign key.  I do 

this

    'to stop the application from errors.  -- Meaning, if the user

    'searches through an inventory record with an invalid manid, you 

would

    'get a Run-time error.

    '--Probably not the best solution for a real-world solution, but 

for this

    'assignment, yes.

    lManID = Data1.Recordset!manid

    sSQLMan2 = "select * from inventory where manid = " _

    & lManID

    cnnBikes.Open "DSN=csis4490"

    cmdBikes.ActiveConnection = "DSN=csis4490"

    cmdBikes.CommandType = adCmdText

    cmdBikes.CommandText = sSQLMan2

    With rsMan2

        .LockType = adLockOptimistic

        .CursorType = adOpenDynamic

        .CursorLocation = adUseClient

        .Open cmdBikes

    End With

    If rsMan2.RecordCount > 0 Then

        rsMan2.MoveFirst

        Do Until rsMan2.EOF

            rsMan2.Delete

            rsMan2.MoveNext

        Loop

    End If

    .Delete

    cnnBikes.Close

    rsMan2.Close

Else

    MsgBox "Delete Operation Has Been Cancelled!"

End If

.Requery

End With

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Man

End Sub

Private Sub cmdModifyInv_Click()

'This button allows the user to push changes made to an Inventory

' record to the MySQL database.  I test to see if the user has made

' any changes to the existing record.  If they have not made changes to 

the

' record, I empty out the boxes - amusement

'

'If the user has made a modification, I pass the changes to the 

database

' and then send them a confirmation of the record modified.

'

Call Disable_Manufacturer_Boxes

Call Enable_Inventory_Boxes

With Data1.Recordset

    If (txtSrchInvModel.Text = .Fields(0)) And _

        (txtSrchInvColor.Text = .Fields(1)) And _

        (txtSrchInvSize.Text = .Fields(2)) And _

        (txtSrchInvGender.Text = .Fields(3)) And _

        (txtSrchInvInStock.Text = .Fields(4)) And _

        (txtSrchInvOnOrder.Text = .Fields(5)) Then

        MsgBox "You did not change anything! Bye!"

    Else

        .Fields(0) = txtSrchInvModel.Text

        .Fields(1) = txtSrchInvColor.Text

        .Fields(2) = txtSrchInvSize.Text

        .Fields(3) = txtSrchInvGender.Text

        .Fields(4) = txtSrchInvInStock.Text

        .Fields(5) = txtSrchInvOnOrder.Text

         MsgBox "You just modified Inventory # " & .Fields(7)

    .Update

    .Requery

    End If

End With

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Inv

End Sub

Private Sub cmdModifyMan_Click()

'This button allows the user to push changes made to an Manufacturer

' record to the MySQL database.  I test to see if the user has made

' any changes to the existing record.  If they have not made changes to 

the

' record, I empty out the boxes - amusement

'

'If the user has made a modification, I pass the changes to the 

database

' and then send them a confirmation of the record modified.

'

Call Enable_Manufacturer_Boxes

Call Disable_Inventory_Boxes

With Data1.Recordset

    If (cboManName.Text = .Fields(0)) And _

        (txtAddressOne.Text = .Fields(1)) And _

        (txtAddressTwo.Text = .Fields(2)) And _

        (txtCity.Text = .Fields(3)) And _

        (txtState.Text = .Fields(4)) And _

        (txtCountry.Text = .Fields(5)) And _

        (txtMailCode.Text = .Fields(6)) And _

        (txtContact.Text = .Fields(7)) And _

        (txtPhone.Text = .Fields(8)) And _

        (txtEmail.Text = .Fields(9)) Then

        MsgBox "You did not change anything! Bye!"

    Else

        .Fields(0) = cboManName.Text

        .Fields(1) = txtAddressOne.Text

        .Fields(2) = txtAddressTwo.Text

        .Fields(3) = txtCity.Text

        .Fields(4) = txtState.Text

        .Fields(5) = txtCountry.Text

        .Fields(6) = txtMailCode.Text

        .Fields(7) = txtContact.Text

        .Fields(8) = txtPhone.Text

        .Fields(9) = txtEmail.Text

         MsgBox "You just modified Manufacturer # " & .Fields(10)

    .Update

    .Requery

    End If

End With

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Man

End Sub

Private Sub cmdQuit_Click()

'Terminate the program when the Quit button is clicked.

Unload Me

End Sub

Private Sub cmdSaveInventory_Click()

'This button creates the Inventory record in the MySQL database.  I 

first

' make sure all of the appropriate boxes are filled in.  If they are

' then I create the record in the database and then let the user

' know what record they just added.

'

'

Call Disable_Manufacturer_Boxes

Call Enable_Inventory_Boxes

With Data1.Recordset

    If (txtSrchInvModel.Text = "") Or _

        (txtSrchInvColor.Text = "") Or _

        (txtSrchInvSize.Text = "") Or _

        (txtSrchInvGender.Text = "") Or _

        (txtSrchInvInStock.Text = "") Or _

        (txtSrchInvOnOrder.Text = "") Then

        MsgBox "You must have all boxes filled in! Bye!"

    Else

        If (cboManName.Text = "") Or _

            (txtAddressOne.Text = "") Or _

            (txtAddressTwo.Text = "") Or _

            (txtCity.Text = "") Or _

            (txtState.Text = "") Or _

            (txtCountry.Text = "") Or _

            (txtMailCode.Text = "") Or _

            (txtContact.Text = "") Or _

            (txtPhone.Text = "") Or _

            (txtEmail.Text = "") Then

                MsgBox "You must fill in all the manufacturer boxes!" _

                & " You might need to first add the manufacturer if " _

                & "you have not already!"

        Else

            .AddNew

            .Fields(0) = txtSrchInvModel.Text

            .Fields(1) = txtSrchInvColor.Text

            .Fields(2) = txtSrchInvSize.Text

            .Fields(3) = txtSrchInvGender.Text

            .Fields(4) = txtSrchInvInStock.Text

            .Fields(5) = txtSrchInvOnOrder.Text

            .Fields(6) = txtManID.Text

            .Update

            MsgBox "You just Added Inventory # " & .Fields(7)

            .Requery

        End If

    End If

    .MoveFirst

End With

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Inv

End Sub

Private Sub cmdSaveMan_Click()

'This button creates the Manufacturer record in the MySQL database.  I 

first

' make sure all of the appropriate boxes are filled in.  If they are

' then I create the record in the database and then let the user

' know what record they just added.

'

'

Call Enable_Manufacturer_Boxes

Call Disable_Inventory_Boxes

With Data1.Recordset

    If (cboManName.Text = "") Or _

        (txtAddressOne.Text = "") Or _

        (txtAddressTwo.Text = "") Or _

        (txtCity.Text = "") Or _

        (txtState.Text = "") Or _

        (txtCountry.Text = "") Or _

        (txtMailCode.Text = "") Or _

        (txtContact.Text = "") Or _

        (txtPhone.Text = "") Or _

        (txtEmail.Text = "") Then

        MsgBox "You must fill in all the boxes! Bye!"

    Else

        .AddNew

        .Fields(0) = cboManName.Text

        .Fields(1) = txtAddressOne.Text

        .Fields(2) = txtAddressTwo.Text

        .Fields(3) = txtCity.Text

        .Fields(4) = txtState.Text

        .Fields(5) = txtCountry.Text

        .Fields(6) = txtMailCode.Text

        .Fields(7) = txtContact.Text

        .Fields(8) = txtPhone.Text

        .Fields(9) = txtEmail.Text

        .Update

        MsgBox "You just modified Manufacturer # " & .Fields(10)

        .Requery

    End If

End With

Call Empty_Inventory_Boxes

Call Empty_Manufacturer_Boxes_Man

End Sub

Private Sub cmdSearchInventory_Click()

'This button click opens the Search Inventory frame and displays the 

inventory list

'for the user.  I will allow the user to select the records either 

through the buttons

'on the fram or through the list box.

txtWhichSearch.Text = "Inv"

cmdSaveInventory.Visible = False

cmdModifyInv.Visible = True

cmdDeleteInventory.Visible = True

cmdSaveMan.Visible = False

cmdModifyMan.Visible = False

cmdDeleteManufacturer.Visible = False

Call Connect_Data1_With_Inv

Call Enable_Search_Buttons

Call Disable_Manufacturer_Boxes

Call Enable_Inventory_Boxes

Call Fill_Inventory_Boxes

Call Attach_Manufacturer

End Sub

Private Sub cmdSrchInvFirst_Click()

'this button moves the data to the first record in the table

If txtWhichSearch.Text = "Inv" Then

 Data1.Recordset.MoveFirst

 Call Enable_Inventory_Boxes

 Call Fill_Inventory_Boxes

 Call Attach_Manufacturer

 Call Disable_Manufacturer_Boxes

Else

 Data1.Recordset.MoveFirst

 Call Enable_Manufacturer_Boxes

 Call Disable_Inventory_Boxes

 Call Fill_Manufacturer_Boxes_Man

End If

End Sub

Private Sub cmdSrchInvLast_Click()

'this button moves the data to the last record in the table

If txtWhichSearch.Text = "Inv" Then

 Data1.Recordset.MoveLast

 Call Disable_Manufacturer_Boxes

 Call Enable_Inventory_Boxes

 Call Fill_Inventory_Boxes

 Call Attach_Manufacturer

Else

 Data1.Recordset.MoveLast

 Call Enable_Manufacturer_Boxes

 Call Disable_Inventory_Boxes

 Call Fill_Manufacturer_Boxes_Man

End If

End Sub

Private Sub cmdSrchInvNext_Click()

'This button moves the user to the next record in the table

If txtWhichSearch.Text = "Inv" Then

    With Data1.Recordset

        .MoveNext

    If .EOF Then

        .MoveFirst

    End If

    End With

    Call Enable_Inventory_Boxes

    Call Disable_Manufacturer_Boxes

    Call Fill_Inventory_Boxes

    Call Attach_Manufacturer

Else

    With Data1.Recordset

        .MoveNext

    If .EOF Then

        .MoveFirst

    End If

    End With

    Call Enable_Manufacturer_Boxes

    Call Disable_Inventory_Boxes

    Call Fill_Manufacturer_Boxes_Man

End If

End Sub

Private Sub cmdSrchInvPrevious_Click()

'This button moves the user to the previous record in the table

If txtWhichSearch.Text = "Inv" Then

    With Data1.Recordset

        .MovePrevious

    If .BOF Then

        .MoveLast

    End If

    End With

    Call Disable_Manufacturer_Boxes

    Call Enable_Inventory_Boxes

    Call Fill_Inventory_Boxes

    Call Attach_Manufacturer

Else

    With Data1.Recordset

        .MovePrevious

    If .BOF Then

        .MoveLast

    End If

    End With

    Call Enable_Manufacturer_Boxes

    Call Disable_Inventory_Boxes

    Call Fill_Manufacturer_Boxes_Man

End If

End Sub

Private Sub Fill_Inventory_Boxes()

'Fills the Inventory boxes on the form

With Data1.Recordset

    txtSrchInvModel.Text = .Fields(0)

    txtSrchInvColor.Text = .Fields(1)

    txtSrchInvSize.Text = .Fields(2)

    txtSrchInvGender.Text = .Fields(3)

    txtSrchInvInStock.Text = .Fields(4)

    txtSrchInvOnOrder.Text = .Fields(5)

End With

End Sub

Private Sub dtgInventory_Click()

'This feature allows the user to click on the data grid and populate

'the corresponding fields- depending on which data is being shown.

If txtWhichSearch.Text = "Inv" Then

    lInvID = Data1.Recordset!invid

    sSQLMan3 = "select * from inventory where invid = " _

    & lInvID

    cnnBikes2.Open "DSN=csis4490"

    cmdBikes2.ActiveConnection = "DSN=csis4490"

    cmdBikes2.CommandType = adCmdText

    cmdBikes2.CommandText = sSQLMan3

    With rsMan

        .LockType = adLockOptimistic

        .CursorType = adOpenDynamic

        .CursorLocation = adUseClient

        .Open cmdBikes

        txtSrchInvModel.Text = .Fields(0)

        txtSrchInvColor.Text = .Fields(1)

        txtSrchInvSize.Text = .Fields(2)

        txtSrchInvGender.Text = .Fields(3)

        txtSrchInvInStock.Text = .Fields(4)

        txtSrchInvOnOrder.Text = .Fields(5)

    End With

        txtWhichSearch.Text = "Inv"

        cmdSaveInventory.Visible = False

        cmdModifyInv.Visible = True

        cmdDeleteInventory.Visible = True

        cmdSaveMan.Visible = False

        cmdModifyMan.Visible = False

        cmdDeleteManufacturer.Visible = False

        Call Enable_Search_Buttons

        Call Disable_Manufacturer_Boxes

        Call Enable_Inventory_Boxes

        Call Fill_Inventory_Boxes

        Call Attach_Manufacturer

        cnnBikes2.Close

        rsMan.Close

Else

    lInvID = Data1.Recordset!manid

    sSQLMan3 = "select * from manufacturer where manid = " _

    & lInvID

    cnnBikes2.Open "DSN=csis4490"

    cmdBikes2.ActiveConnection = "DSN=csis4490"

    cmdBikes2.CommandType = adCmdText

    cmdBikes2.CommandText = sSQLMan3

    With rsMan

        .LockType = adLockOptimistic

        .CursorType = adOpenDynamic

        .CursorLocation = adUseClient

        .Open cmdBikes2

        cboManName.Text = .Fields(0)

        txtAddressOne.Text = .Fields(1)

        txtAddressTwo.Text = .Fields(2)

        txtCity.Text = .Fields(3)

        txtState.Text = .Fields(4)

        txtCountry.Text = .Fields(5)

        txtMailCode.Text = .Fields(6)

        txtContact.Text = .Fields(7)

        txtPhone.Text = .Fields(8)

        txtEmail.Text = .Fields(9)

        txtManID.Text = .Fields(10)

    End With

        txtWhichSearch.Text = "Man"

        cmdSaveMan.Visible = False

        cmdModifyMan.Visible = True

        cmdDeleteManufacturer.Visible = True

        cmdSaveInventory.Visible = False

        cmdModifyInv.Visible = False

        cmdDeleteInventory.Visible = False

        Call Enable_Search_Buttons

        Call Enable_Manufacturer_Boxes

        Call Empty_Inventory_Boxes

        Call Disable_Inventory_Boxes

        Call Fill_Manufacturer_Boxes_Man

        cnnBikes2.Close

        rsMan.Close

End If

End Sub

Private Sub Form_Load()

'This is where I make the connection to the MySQL database.

sSQLInv = "select * from inventory"

sSQLMan = "select * from manufacturer"

End Sub

Private Sub Attach_Manufacturer()

'Sets the appropriate manufacturer info based on the inventory item

lManID = Data1.Recordset!manid

sSQLMan2 = "select * from manufacturer where manid = " _

    & lManID

cnnBikes.Open "DSN=csis4490"

cmdBikes.ActiveConnection = "DSN=csis4490"

cmdBikes.CommandType = adCmdText

cmdBikes.CommandText = sSQLMan2

With rsMan2

    .LockType = adLockOptimistic

    .CursorType = adOpenDynamic

    .CursorLocation = adUseClient

    .Open cmdBikes

End With

Call Fill_Manufacturer_Boxes_Inv

cnnBikes.Close

rsMan2.Close

End Sub

Private Sub Fill_Manufacturer_Boxes_Inv()

'Fills the Manufacturer Boxes

With rsMan2

    cboManName.Text = .Fields(0)

    txtAddressOne.Text = .Fields(1)

    txtAddressTwo.Text = .Fields(2)

    txtCity.Text = .Fields(3)

    txtState.Text = .Fields(4)

    txtCountry.Text = .Fields(5)

    txtMailCode.Text = .Fields(6)

    txtContact.Text = .Fields(7)

    txtPhone.Text = .Fields(8)

    txtEmail.Text = .Fields(9)

    txtManID.Text = .Fields(10)

End With

End Sub

Private Sub Empty_Manufacturer_Boxes_Inv()

'Empties the manufacturer fields on the form

With rsMan2

    cboManName.Text = ""

    txtAddressOne.Text = ""

    txtAddressTwo.Text = ""

    txtCity.Text = ""

    txtState.Text = ""

    txtCountry.Text = ""

    txtMailCode.Text = ""

    txtContact.Text = ""

    txtPhone.Text = ""

    txtEmail.Text = ""

End With

End Sub

Private Sub Empty_Inventory_Boxes()

'Empties the Inventory boxes on the form

With Data1.Recordset

    txtSrchInvModel.Text = ""

    txtSrchInvColor.Text = ""

    txtSrchInvSize.Text = ""

    txtSrchInvGender.Text = ""

    txtSrchInvInStock.Text = ""

    txtSrchInvOnOrder.Text = ""

End With

End Sub

Private Sub Fill_Manufacturer_Boxes_Man()

'Fills the Manufacturer Boxes

With Data1.Recordset

    cboManName.Text = .Fields(0)

    txtAddressOne.Text = .Fields(1)

    txtAddressTwo.Text = .Fields(2)

    txtCity.Text = .Fields(3)

    txtState.Text = .Fields(4)

    txtCountry.Text = .Fields(5)

    txtMailCode.Text = .Fields(6)

    txtContact.Text = .Fields(7)

    txtPhone.Text = .Fields(8)

    txtEmail.Text = .Fields(9)

    txtManID.Text = .Fields(10)

End With

End Sub

Private Sub Disable_Inventory_Boxes()

'Disables the Inventory boxes

txtSrchInvColor.Enabled = False

txtSrchInvModel.Enabled = False

txtSrchInvSize.Enabled = False

txtSrchInvGender.Enabled = False

txtSrchInvInStock.Enabled = False

txtSrchInvOnOrder.Enabled = False

End Sub

Private Sub Enable_Inventory_Boxes()

'Enables the Inventory boxes

txtSrchInvColor.Enabled = True

txtSrchInvModel.Enabled = True

txtSrchInvSize.Enabled = True

txtSrchInvGender.Enabled = True

txtSrchInvInStock.Enabled = True

txtSrchInvOnOrder.Enabled = True

End Sub

Private Sub cmdSearchManufacturer_Click()

'This button click displays the manufacturer list

'for the user.  I will allow the user to select the records either 

through the buttons

'on the frame or through the list box.

txtWhichSearch.Text = "Man"

cmdSaveMan.Visible = False

cmdModifyMan.Visible = True

cmdDeleteManufacturer.Visible = True

cmdSaveInventory.Visible = False

cmdModifyInv.Visible = False

cmdDeleteInventory.Visible = False

Call Connect_Data1_With_Man

Call Enable_Search_Buttons

Call Enable_Manufacturer_Boxes

Call Empty_Inventory_Boxes

Call Disable_Inventory_Boxes

Call Fill_Manufacturer_Boxes_Man

End Sub

Private Sub Disable_Manufacturer_Boxes()

'Disables the Manufacturer Boxes

    cboManName.Enabled = False

    txtAddressOne.Enabled = False

    txtAddressTwo.Enabled = False

    txtCity.Enabled = False

    txtState.Enabled = False

    txtCountry.Enabled = False

    txtMailCode.Enabled = False

    txtContact.Enabled = False

    txtPhone.Enabled = False

    txtEmail.Enabled = False

End Sub

Private Sub Enable_Manufacturer_Boxes()

'Enables the Manufacturer Boxes

    cboManName.Enabled = True

    txtAddressOne.Enabled = True

    txtAddressTwo.Enabled = True

    txtCity.Enabled = True

    txtState.Enabled = True

    txtCountry.Enabled = True

    txtMailCode.Enabled = True

    txtContact.Enabled = True

    txtPhone.Enabled = True

    txtEmail.Enabled = True

End Sub

Private Sub Disable_Search_Buttons()

'This disables the search buttons so the user cannot use them

cmdSrchInvFirst.Enabled = False

cmdSrchInvNext.Enabled = False

cmdSrchInvPrevious.Enabled = False

cmdSrchInvLast.Enabled = False

End Sub

Private Sub Enable_Search_Buttons()

'This enables the search buttons so the user cannot use them

cmdSrchInvFirst.Enabled = True

cmdSrchInvNext.Enabled = True

cmdSrchInvPrevious.Enabled = True

cmdSrchInvLast.Enabled = True

End Sub

Private Sub Empty_Manufacturer_Boxes_Man()

'Empties the manufacturer fields on the form

With Data2.Recordset

    cboManName.Text = ""

    txtAddressOne.Text = ""

    txtAddressTwo.Text = ""

    txtCity.Text = ""

    txtState.Text = ""

    txtCountry.Text = ""

    txtMailCode.Text = ""

    txtContact.Text = ""

    txtPhone.Text = ""

    txtEmail.Text = ""

End With

End Sub

Private Sub Connect_Data2_With_Man()

'Connect the second data control to the manufacturer's table

Data2.ConnectionString = "DSN=csis4490"

Data2.CommandType = adCmdText

Data2.RecordSource = sSQLMan

Data2.Refresh

End Sub

Private Sub Connect_Data1_With_Man()

'connect the first data control to the manufacturer's table

Data1.ConnectionString = "DSN=csis4490"

Data1.CommandType = adCmdText

Data1.RecordSource = sSQLMan

Data1.Refresh

End Sub

Private Sub Connect_Data1_With_Inv()

'connect the first data control to the inventory table

Data1.ConnectionString = "DSN=csis4490"

Data1.CommandType = adCmdText

Data1.RecordSource = sSQLInv

Data1.Refresh

End Sub

Appendix D

Installing and Using ODBC in Client/Server Architecture

Open DataBase Connectivity (ODBC) is an effort to provide a "standard" way to access databases from a variety of vendors.  With the proper ODBC drivers and setup, the database being used can be changed from MySQL to SQL Server  to Sybase to Oracle without significantly changing the data processing code in an application.  The only code change would be the Data Set Name (DSN) - the name of the ODBC driver.

ODBC is a primarily Windows- based data interface, although there are some exceptions (Cold Fusion running on a UNIX( or Linux based Web server).

ODBC drivers are specific to the database to be accessed and are available from the database vendor (all databases) and from third parties, such as Intersolv, for some databases.  Some vendors provide free ODBC drivers (MySQL, Oracle) and others charge by the copy (Sybase).  

There are sometimes compatibility problems between different releases of a given ODBC driver.  An annoying example was the difference between Sybase's  16 bit drivers in versions 2.10 and 2.11 - the changes caused working applications to fail.

Most ODBC drivers have an installation program that puts the needed files in the proper place and makes any needed entries in the Windows registry.  Many are DLL based, although Oracle's latest ODBC drivers are Java-based.  See Appendix H for steps and screen shots of installing the MySQL drivers on a Windows 95 PC.

Probably the cheapest and easiest to use database and associated ODBC drivers is MySQL, available from http://www.mysql.org.   Although it is a commercial product, it is free for certain uses.  MySQL supports a rich set of SQL statements and is relatively easy to configure.  It also has a very small footprint, requiring on 25MB of disk space for the MySQL installation (plus space for your data).  MySQL will also provide acceptable performance for small database projects on almost any Pentium class PC and is available for Windows 95 through Windows 2000.

In a sample project with two laptops as workstations in a hypothetical small business, Windows NT 4.0 Workstation was used as the operating system on a Pentium 100 PC with 48MB RAM - not exactly a state-of-the-art "server."   Using a 10Mbs Ethernet LAN to connect the various computers, there was little delay in accessing the data in the MySQL database used for testing.  No detailed measurements were made, but the user perspective was that data was available "immediately."

How do you get it to work?

 1. Install the MySQL server software on an appropriate PC; then follow the configuration instructions in the setup documents.  The documentation also includes a tutorial.

2. Create a database in MySQL.

3. Install the MySQL ODBC drivers on the client PC and configure it using the ODBC Data Sources (32 bit) utility in the Windows Control Panel.  

Create a name for the driver, usually one that indicates the database or server that it connects to, or the application that it will be used with.  If you're building a database for the CSIS4490 class, csis4490 might be a good name.  

Provide either the system name or IP address of the server.  If you plan to use a single PC as server and client, use "localhost" as the name.

Put in the name of the database to be accessed on the server - that's one reason for creating the database first.

Add the user name and password of the default user (if needed - you can also specify the user name and password in the ODBC call that opens the database).

Check any options you need (try your application before changing the defaults).


Later versions of the MySQL drivers (3.51) have a test button that you can use to verify that the database is accessible.

    Now you're at the point of connecting to the database and using it.  Options for getting and manipulating the data include:

1. write your own interface in Visual Basic, Java, etc.

2. use the "Get External Data" option in Microsoft Access to link to the MySQL tables 

3. use MSQuery to access the data from Word or Excel

4. use VBA from either Word or Excel

5. use any other ODBC-aware Windows application to access the data

    The Access connection for data manipulation is the easiest to implement.  Select File->Get External Data->Link Tables->Files of Type->ODBC Databases, then select the Data Set Name (DSN) for MySQL.  The ODBC driver will connect to the database and display a list of the tables available.  Select the tables you wish to use and click OK.  You can now manipulate the tables just as you would any other Access table.  Create, read, update, and delete entries in dataview, build queries, write macros and modules, and use all the other Access capabilities.  See Appendix I for screen shots of using Access with MySQL.

    Using VBA in Excel requires that the optional Excel ODBC Add-In be installed on the PC.  This may not be included in a typical installation of the Office software.  If you need specific data analysis functions, Excel also requires the Analysis ToolPak - (VBA).  You can check for whether these add-ins are installed or available in Excel by clicking Tools->Add-Ins to see the list of available add-ins (see Appendix J).  Each currently installed add-in is indicated by a check mark.  Although VBA programming will be relatively easy for someone with experience in Visual Basic, detailed instructions are beyond the scope of this document.  Some sample code and some hints and tips that will make data access via ODBC easier for the first time VBA programmer are included in Appendix E.

Appendix E

'Code Copyright ( John E. Carter 1997-2002

'email: johnecarter at mindspring dot com

'Well thought out questions will be answered.  

'Requests to write your course project will be billed at $50/hour, minimum of 2 hours.

'common variables

Public conString As String  'connection string for database access

'line numbers in code provide location reference in the error handler

'Status sheet tracks results from many operations for trouble shooting

' get_data_Click Macro

'

Sub get_data_Click()

1 On Error GoTo errorhandler

Dim mysql$, clearange$

Dim servername As String, MySQLopen As String

5 Dim wksht As Object

Set wksht = Worksheets("Data")

20 Sheets("Data").Range("b1").Select 'unused cell

'label used for progress messages is not attached to the undelying cell

Sheets("Data").Labels("Label 41").Placement = xlFreeFloating

Sheets("Data").Labels("Label 41").Text = "Verifying data range"

Sheets("Data").Labels("Label 41").Visible = True

DoEvents  'allow hourglass cursor to show

'save current date/time

Sheets("Status").Range("h1") = Now()

Sheets("Status").Range("h2").ClearContents

'clear area for incoming data

clearange$ = "a6:l55"  'not likely to have more than this

Sheets("Data").Range("i1").ClearContents

90 Sheets("Data").Range(clearange$).ClearContents

'show progress

Sheets("Data").Labels("Label 41").Text = "Opening connection"

100 DoEvents

'open connection - valid connection is a small value, usually less than 10

If conString = "" Then Error 99  'no DSN specified

MySQLopen = conString  'DSN selected by IP or Name button

115 thisconn = SQLOpen(MySQLopen, , 2)

If IsError(thisconn) Then Error 9999       'invalid response from server

120 Sheets("Status").Range("b2") = thisconn

'error messages from each SQL operation are placed on Status sheet

130 Sheets("Status").Range("b15") = sqlerror()

Sheets("Data").Labels("Label 41").Text = "Executing query"

mysql$ = "select model, color, size, instock from inventory"

'send query

140 Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

145 Sheets("Status").Range("b17") = sqlerror()

'bind columns to fields in the rows to be returned - one sqlbind per field retrieved

150 Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("a6"))

Sheets("Status").Range("b19") = sqlerror()

160 Sheets("Status").Range("c5") = sqlbind(thisconn, 2, Sheets("Data").Range("b6"))

Sheets("Status").Range("b21") = sqlerror()

170 Sheets("Status").Range("d5") = sqlbind(thisconn, 3, Sheets("Data").Range("c6"))

Sheets("Status").Range("b23") = sqlerror()

180 Sheets("Status").Range("e5") = sqlbind(thisconn, 4, Sheets("Data").Range("d6"))

Sheets("Status").Range("b25") = sqlerror()

190 Sheets("Status").Range("f5") = sqlbind(thisconn, 5, Sheets("Data").Range("e6"))

Sheets("Status").Range("b27") = sqlerror()

200 Sheets("Status").Range("g5") = sqlbind(thisconn, 6, Sheets("Data").Range("f6"))

Sheets("Status").Range("b29") = sqlerror()

'retrieve data into cells

210 Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("a6"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

215 If Not IsEmpty(Sheets("Status").Range("b6")) Then 'save the count of returned rows

       Sheets("Data").Range("l1") = Sheets("Status").Range("b6")

End If

'query for chart series 1 - one query per sum retrieved

mysql$ = "select sum(instock) from inventory where size = 19;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("f7"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("f7"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()  'each operation is checked for error

mysql$ = "select sum(instock) from inventory where size = 20;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("g7"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("g7"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

mysql$ = "select sum(instock) from inventory where size = 22;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("h7"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("h7"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

mysql$ = "select sum(instock) from inventory where size = 24;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("i7"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("i7"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

mysql$ = "select sum(instock) from inventory where size = 25;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("f8"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("f8"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

mysql$ = "select sum(instock) from inventory where size = 26;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("g8"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("g8"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

mysql$ = "select sum(instock) from inventory where size = 27;"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("h8"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("h8"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

'queries complete

Sheets("Data").Labels("Label 41").Text = "Closing connection"

DoEvents                 'allow screen to update

'close connection

220 Sheets("Status").Range("b7") = sqlclose(thisconn)

Sheets("Status").Range("b33") = sqlerror()

'ensure first row is displayed

Sheets("Data").Range("a6").Select

Sheets("Data").Range("b1").Select

'save date/time of end of request

Sheets("Status").Range("h2") = Now()

245 Exit Sub  'we're done

errorhandler:               'traps most errors

If Err = 9999 Then

  MsgBox "Server Error: " & servername & " is not responding." & Chr$(10) & Chr$(13) & "Please try again later.", 16, "ODBC Demo"

  Sheets("Data").Labels("Label 41").Text = ""

ElseIf Err = 99 Then

  MsgBox "Choose IP or server name before requesting data"

Else

250    MsgBox "Encountered error " & Err & " at line " & Format$(Erl), 16, "ODBC Demo "

End If

260  Err = 0

270  sqlclose (thisconn)      'close connection if any error encountered

Sheets("Status").Range("b33") = sqlerror()

End Sub

Sub clearcells()

  Sheets("Data").Range("a6:l55").ClearContents  'clear area used for inventory display

End Sub

Sub close_conn()   ' used during testing to ensure all connections are closed after failure

  For k% = 1 To 5

    sqlclose (k%)

  Next k%

End Sub

Sub clear_data()  ' clear Data sheet

  clearange$ = "a6:l55"

  Sheets("Data").Range(clearange$).ClearContents

  Sheets("Data").Range("i4:j4").ClearContents

  Sheets("Data").Range("l1").ClearContents

  Sheets("Data").Range("e1").ClearContents

  Sheets("Data").Range("b2").ClearContents

  Sheets("Data").Range("a6").Select

  Sheets("Data").Range("b1").Select

End Sub

Sub showlabel()

  Sheets("Data").Labels("Label 41").Visible = True

End Sub

Sub UseIP()

  conString = "DSN=ip4490"  'this DSN has the server's IP address

End Sub

Sub UseName()

  conString = "DSN=csis4490"  'this DSN has the server's name

End Sub

' This is working code, but is also the hints and tips section
'Something every ODBC user should know

'SQL query as a string can only be 255 characters.

'This converts it to an array, which can be much larger.

'From http://www.j-walk.com/ss/excel/faqs/xl95faq3.htm

Function StringToArray(Query As String) As Variant

 Const StrLen = 127      'Set the maximum string length for

                         'each element in the array to 127 characters.

 Dim NumElems As Integer

 Dim Temp() As String

                      'Divide the length of the string Query by StrLen and add

                      '1 to determine how many elements the String array Temp

                      'should contain and redimension the Temp array to contain

                      'this number of elements.

 NumElems = (Len(Query) / StrLen) + 1

 ReDim Temp(1 To NumElems) As String

                      'Build the Temp array by sequentially extracting 127

                      'segments of the Query string into each element of the

                      'Temp array.

'Log function added by John E. Carter

 logpath$ = Application.Path & "\sqlquery.txt"

 Open logpath$ For Output As 1

 Print #1, Date$, Time$, "mysqlodbc.xls"

 For i = 1 To NumElems

   Temp(i) = Mid(Query, ((i - 1) * StrLen) + 1, StrLen)

   Print #1, Temp(i)

 Next i

 Print #1, ""

 Close 1

                      'Set the function StringToArray to the Temp array so it

                      'can be returned to the calling procedure

 StringToArray = Temp

End Function

'get_con returns connection string from MSQuery

'you can use MSQuery to create a connection string if you can't determine it 

'DSN=UTEST;UID=testid;SRVR=dante;DB=CLDS_USER_DB;PWD=john1

Sub get_con()

  chan = Application.DDEInitiate("MSQuery", "Query1")

  connect = Application.DDERequest(chan, "ConnectionString")

  Sheets("Status").Range("a1") = connect

  Application.DDETerminate chan

End Sub

'for more serious testing, this will repeat the process 100 times

Sub Load()

Dim i As Integer

For i = 1 To 100

  Sheets("Data").Range("e1") = i

 get_data_Click()

Next i

End Sub

Appendix F

SQL Code to Create MySQL Database on the Server
The MySQL database used in the above examples:

C:\mysql\bin>mysql

Welcome to the MySQL monitor.  Commands end with ; or \g.

Your MySQL connection id is 1 to server version: 3.23.47-max-debug

Type 'help;' or '\h' for help. Type '\c' to clear the buffer.

mysql> create database csis4490;

Query OK, 1 row affected (0.88 sec)

mysql> use csis4490;

Database changed

mysql> create table inventory (model char(10) Not Null, color char(10) Not Null, size int(11) Not Null Default 0, gender char(1) Not Null, instock int(11) Default 0, onorder int(1) Not Null, manid int(9) Not Null Default 0, invid int(9) Not Null Auto_Increment, Primary Key (invid), Unique id (invid),FOREIGN KEY(manid) REFERENCES manufacturer(manid) );

Table created

mysql> create table manufacturer (company char(25) Not Null, address1 char(25) Not Null, address2 char(25), city char(15) Not Null, state char(12) , country char(12) Not Null, mailcode char(12), contact char(25), phone char(12), email char(30),manid int(9) Not Null Auto_Increment, Primary Key (manid), Unique id (manid) );

Table created

mysql> grant all privileges on csis4490.* to bob@"%";

Query OK, 1 row affected (0.66 sec)

mysql> show tables;

+--------------------+

| Tables_in_csis4490 |

+--------------------+

| inventory          |

| manufacturer       |

+--------------------+

2 rows in set (0.88 sec)

mysql> desc inventory;

+---------+--------------+------+-----+---------+----------------+

| Field   | Type         | Null | Key | Default | Extra          |

+---------+--------------+------+-----+---------+----------------+

| model   | char(10)     |      |     |         |                |

| color   | char(10)     |      |     |         |                |

| size    | int(11)      |      |     | 0       |                |

| gender  | char(1)      |      |     |         |                |

| instock | int(11)      | YES  |     | 0       |                |

| onorder | tinyint(1)   |      |     | 0       |                |

| manid   | mediumint(9) |      |     | 0       |                |

| invid   | mediumint(9) |      | PRI | NULL    | auto_increment |

+---------+--------------+------+-----+---------+----------------+

8 rows in set (0.60 sec)

mysql> desc manufacturer;

+----------+--------------+------+-----+---------+----------------+

| Field    | Type         | Null | Key | Default | Extra          |

+----------+--------------+------+-----+---------+----------------+

| company  | char(25)     |      |     |         |                |

| address1 | char(25)     |      |     |         |                |

| address2 | char(25)     | YES  |     | NULL    |                |

| city     | char(15)     |      |     |         |                |

| state    | char(12)     | YES  |     | NULL    |                |

| country  | char(12)     |      |     |         |                |

| mailcode | char(12)     | YES  |     | NULL    |                |

| contact  | char(25)     | YES  |     | NULL    |                |

| phone    | char(12)     | YES  |     | NULL    |                |

| email    | char(12)     | YES  |     | NULL    |                |

| manid    | mediumint(9) |      | PRI | NULL    | auto_increment |

+----------+--------------+------+-----+---------+----------------+

11 rows in set (0.22 sec)

Appendix G

ODBC Reference Links
Some links about ODBC:

Microsoft source documentation (bible)

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/odbc/htm/odbcintroduction_to_odbc.asp.asp

latest version of the ODBC SDK and Programmer's Reference 

http://www.microsoft.com/data/odbc/
HOWTO: Configure ODBC Data Sources on the Fly (Q110507)

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q110507
INFO: List of References That Discuss ODBC (Q134391)

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q134391
Online ODBC Programmer's Reference

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/odbc/htm/odbcintroduction_to_odbc.asp

DSN and ODBC background and history

http://www.metropolitian.net/article.php?sid=45&mode=thread&order=0&thold=0
Powerpoint presentation on Perl and ODBC

http://www.roth.net/perl/odbc/conf/sld001.htm
Appendix H
Screen Shots of ODBC Installation and Configuration

When you double click on the setup(.exe) file, the application brings up this series of windows.
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The splash screen, which starts the Microsoft ODBC setup program.
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Click on Continue to bring up the next screen.
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Select MySQL and click OK.
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The needed files are copied to the various System directories.
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Click Setup to create a new Data Source.
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Define the Data Set Name, computer name or IP Address, database name, user name (and password, if needed), and any options needed.
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ODBC setup complete.

Appendix I

Using MS Access with MySQL ODBC
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Create a new (blank) database that will have access to the MySQL database
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Select File->Get External Data->Link Tables
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Scroll to the bottom of the "Files of Type" box and select ODBC Databases().
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Select the MySQL connection.
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Select the table(s) to use and click OK.
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The selected table(s) will be added to the open Access database.
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The table(s) can now be opened and manipulated in the same manner as any other Access database.

Appendix J

Excel Add-ins Screen Shots and Directions
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Click Tools->Add-Ins
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Available add-ins are shown.  The checked items are currently in use.

Example of data from MySQL database used in the Excel spreadsheet and presented in a chart displaying number of bicycles in stock by frame size.


Appendix K

MS VBA Code used with MS Excel

'John E. Carter

'email: johnecarter at mindspring dot com

'common variables

Public isleap As Integer 'used in main module and in computing times between days

Public conString As String

' get_data_Click Macro

'

Sub get_data_Click()

  test01

End Sub

'

' test01 Macro

'

Sub test01()

1 On Error GoTo errorhandler

Dim mysql$, clearange$

Dim isleap As Integer

Dim servername As String, MySQLopen As String

5 Dim wksht As Object

Set wksht = Worksheets("Data")

20 Sheets("Data").Range("b1").Select 'unused cell

'label used for progress messages is not attached to the undelying cell

Sheets("Data").Labels("Label 41").Placement = xlFreeFloating

Sheets("Data").Labels("Label 41").Text = "Verifying data range"

Sheets("Data").Labels("Label 41").Visible = True

DoEvents  'allow hourglass cursor to show

'save current date/time

Sheets("Status").Range("h1") = Now()

Sheets("Status").Range("h2").ClearContents

'clear area for incoming data

clearange$ = "a6:j50"  'not likely to have more than this

Sheets("Data").Range("i1").ClearContents

90 Sheets("Data").Range(clearange$).ClearContents

Sheets("Data").Labels("Label 41").Text = "Opening connection"

100 DoEvents

'open connection - valid connection is a small value, usually less than 10

If conString = "" Then Error 99

MySQLopen = conString  '"DSN=csis4490"

115 thisconn = SQLOpen(MySQLopen, , 2)

If IsError(thisconn) Then Error 9999  'invalid response from server

120 Sheets("Status").Range("b2") = thisconn

'error messages from each SQL operation are placed on Status sheet

130 Sheets("Status").Range("b15") = sqlerror()

Sheets("Data").Labels("Label 41").Text = "Executing query"

mysql$ = "select model, color, size, instock from inventory"

'send query

140 Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

145 Sheets("Status").Range("b17") = sqlerror()

'bind columns to fields in the rows to be returned

150 Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("a6"))

Sheets("Status").Range("b19") = sqlerror()

160 Sheets("Status").Range("c5") = sqlbind(thisconn, 2, Sheets("Data").Range("b6"))

Sheets("Status").Range("b21") = sqlerror()

170 Sheets("Status").Range("d5") = sqlbind(thisconn, 3, Sheets("Data").Range("c6"))

Sheets("Status").Range("b23") = sqlerror()

180 Sheets("Status").Range("e5") = sqlbind(thisconn, 4, Sheets("Data").Range("d6"))

Sheets("Status").Range("b25") = sqlerror()

190 Sheets("Status").Range("f5") = sqlbind(thisconn, 5, Sheets("Data").Range("e6"))

Sheets("Status").Range("b27") = sqlerror()

200 Sheets("Status").Range("g5") = sqlbind(thisconn, 6, Sheets("Data").Range("f6"))

Sheets("Status").Range("b29") = sqlerror()

'retrieve data into cells

210 Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("a6"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

215 If Not IsEmpty(Sheets("Status").Range("b6")) Then 'save the count of returned rows

       Sheets("Data").Range("l1") = Sheets("Status").Range("b6")

End If

'query for chart series 1

mysql$ = "select amount from sales where manid=1 order by month"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("g7"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("g7"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

mysql$ = "select amount from sales where manid=2 order by month"

Sheets("Status").Range("b4") = sqlexecquery(thisconn, StringToArray(mysql$))

Sheets("Status").Range("b17") = sqlerror()

Sheets("Status").Range("b5") = sqlbind(thisconn, 1, Sheets("Data").Range("h7"))

Sheets("Status").Range("b19") = sqlerror()

Sheets("Status").Range("b6") = sqlretrieve(thisconn, Sheets("Data").Range("h7"), , , False, , , False)

Sheets("Status").Range("b31") = sqlerror()

Sheets("Data").Labels("Label 41").Text = "Closing connection"

DoEvents

'close connection

220 Sheets("Status").Range("b7") = sqlclose(thisconn)

Sheets("Status").Range("b33") = sqlerror()

'ensure first row is displayed

Sheets("Data").Range("a6").Select

Sheets("Data").Range("b1").Select

'save date/time of end of request

Sheets("Status").Range("h2") = Now()

245 Exit Sub

errorhandler:

If Err = 9999 Then

  MsgBox "Server Error: " & servername & " is not responding." & Chr$(10) & Chr$(13) & "Please try again later.", 16, "CLDS Metrics Report"

  Sheets("Data").Labels("Label 41").Text = ""

ElseIf Err = 99 Then

  MsgBox "Choose IP or server name before requesting data"

Else

250    MsgBox "Encountered error " & Err & " at line " & Format$(Erl), 16, "CLDS Metrics Report"

End If

260  Err = 0

270  sqlclose (thisconn)

Sheets("Status").Range("b33") = sqlerror()

End Sub

'SQL query as a string can only be 255 characters.

'This converts it to an array, which can be much larger.

'From http://www.j-walk.com/ss/excel/faqs/xl95faq3.htm

Function StringToArray(Query As String) As Variant

 Const StrLen = 127      'Set the maximum string length for

                         'each element in the array to return

                         'to 127 characters.

 Dim NumElems As Integer

 Dim Temp() As String

                      'Divide the length of the string Query by StrLen and add

                      '1 to determine how many elements the String array Temp

                      'should contain and redimension the Temp array to contain

                      'this number of elements.

 NumElems = (Len(Query) / StrLen) + 1

 ReDim Temp(1 To NumElems) As String

                      'Build the Temp array by sequentially extracting 127

                      'segments of the Query string into each element of the

                      'Temp array.

'Log function added by John E. Carter

 logpath$ = Application.Path & "\sqlquery.txt"

 Open logpath$ For Output As 1

 Print #1, Date$, Time$, "cldsprod.xls"

 For i = 1 To NumElems

   Temp(i) = Mid(Query, ((i - 1) * StrLen) + 1, StrLen)

   Print #1, Temp(i)

 Next i

 Print #1, ""

 Close 1

                      'Set the function StringToArray to the Temp array so it

                      'can be returned to the calling procedure

 StringToArray = Temp

End Function

Sub clearcells()

  Sheets("Data").Range("a6:j55").ClearContents

End Sub

'get_con returns connection string from MSQuery - left from testing

'DSN=CLDSUTEST;UID=cldstestid;SRVR=dante;DB=CLDS_USER_DB;PWD=johnray1

'

Sub get_con()

  chan = Application.DDEInitiate("MSQuery", "Query1")

  connect = Application.DDERequest(chan, "ConnectionString")

  Sheets("Status").Range("a1") = connect

  Application.DDETerminate chan

End Sub

'Sub trimcell() 'left from testing

'  tmp$ = Sheets("sheet1").Range("a1")

'  dashloc% = InStr(tmp$, "-")

'  tmp$ = Left$(tmp$, dashloc% - 1)

'  Sheets("sheet1").Range("a1") = tmp$

'End Sub

Sub close_conn()   ' used during testing. ensure all connections to database closed after failure

  For k% = 1 To 5

    sqlclose (k%)

  Next k%

End Sub

Sub clear_data()  ' clear Data sheet

  clearange$ = "a6:j50"

  Sheets("Data").Range(clearange$).ClearContents

  Sheets("Data").Range("i4:j4").ClearContents

  Sheets("Data").Range("l1").ClearContents

  Sheets("Data").Range("e1").ClearContents

  'Worksheets("Data").Calculate

  Sheets("Data").Range("b2").ClearContents

  Sheets("Data").Range("a6").Select

  Sheets("Data").Range("b1").Select

End Sub

Sub showlabel()

  Sheets("Data").Labels("Label 41").Visible = True

End Sub

Sub UseIP()

  conString = "DSN=ip4490"

End Sub

Sub UseName()

  conString = "DSN=csis4490"

End Sub

Sub Load()

Dim i As Integer

For i = 1 To 100

  Sheets("Data").Range("e1") = i

  test01

Next i

End Sub

Appendix L

Word Mail Merge Using ODBC

Assumption: You know how to create a Merge document in Word and use the Insert Merge Field and Insert Word Field buttons on Word's Merge toolbar.

The easiest way to retrieve data from an ODBC database is with MSQuery (which may or may not have been installed with Office).  A common use is to retrieve name and address data to be used to create mailing labels or form letters in Word.  

To access MSQuery for this purpose:

1. Click Tools->Mail Merge->Create to select the type of document.

2. Select Form Letter->Edit

3. Create the text for the body of the letter - "Congratulations!  You have won a free Florida vacation!"  

4. Click Tools->Mail Merge->Get Data->Open Data Source->MSQuery

5. Select the ODBC driver for the database you're using (say,MySQL) and MSQuery will connect to the database and display a list of the tables available.  

6. Click on the "+" beside a table name to display the fields in that table

7. Use the ">" button to select the fields needed from each table

8. Click Next.  

9. You will be prompted for query options you may wish to use, such as value of a field.  Select the needed items and click Next.  

10. You will be prompted for sort options.  Select the needed items and click Next.  

11. Select "Return data to Word" and click Finish.  

12. You will be prompted to add merge fields to the document. 

13. Click Edit.  The "Insert Merge Fields" button on the menu will now be available.  

14. Click Insert Merge Fields to get a list of the fields you selected from the database.  Clicking an item in the list will insert it at the current cursor position in the document.  Merge fields are identified by the <<fieldname>> convention.   

15. When the fields have been inserted into the document, click Tools->Mail Merge->Merge.  

16. Select "Merge to new document"

17. Click Merge.  MSQuery will access the database and create a new document for each row returned by the query.

    Congratulations!  You just retrieved the data you needed without writing a single line of code.  The following are screen shots of this process.
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Select Tools->Mail Merge to get this menu.  Select Open Data Source to get data from an existing source (in this case, we'll use the ODBC connection via MSQuery).
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Click the MSQuery button on the right to use MSQuery to access the data.
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Select MySQL as the source and click OK.
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Select the desired fields from the table(s) from the box on the left and use the ">" button to copy them to the box on the right, then click Next.

From the next two menus, select any filtering needed (by city, state, etc.) and click Next, then select any ordering needed (alphabetic by last name) and click Finish.  You will be returned to the merge menu, where you will click Merge.
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Select Merge to New Document and click Merge.
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Mr. Joe R Johnson B

1324 West Main St
Maple, VT

April 12,2002
Dear Mr. Johnson

Thank you for your recent purchase. We hope that you are enjoying your new
bicycle. Remernber that seat height and handiebar position adjustments are free
for the first 90 days

We also have a complete line of manufacturer approved accessories for your
bicycle.

Please contact us if we can be of assistance in any manner

Thank yan for voir hisiness
IR
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The merge fields in the document are replaced by the database fields of the same name.

This document created for Kennesaw State University, CSIS4490-3, Spring 2002. 
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